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User Guide versioning

The Web section is constantly looking for ways to im-
prove user experience in the CMS and for this reason, 
menu labels and methods for performing tasks in the 
CMS might vary between the time this guide was written 
(September 12, 2007) and what you see when navigating 
in the CMS. For a complete list of  updates to the CMS, 
please visit our CrownPeak training Web site at 
http://cowwwdev1/cms_training/index.html.

What you’ll need to work in the CMS

An Internet connection
Internet Explorer 6 (IE6) or Internet Explorer 7  

 (IE7) Web browser
The URL address of  the CMS – 

 http://advantage8.crownpeak.com/vdot

An account – If  you are a user of  CONRAD   
 you should already have an account set up and 
 have received it from the Web section. If  not,   
 please see the contact information at the end 
 of  this document to request for a username and   
 password. The default information for all new 
 accounts are as follows:

»
»

»

»

INTRODUCTION
CrownPeak CMS is a software tool that allows 
users to manage Web site content easily and 
within a predetermined site design and 
structure. CrownPeak CMS puts Web content 
publishing into the hands of  all users without 
the need for in depth understanding of  Web 
site development.

How does it all work?

This process consists of  three parts: the CMS, you the 
CMS user and the Web section. The CMS lets you put 
your content straight on to Virginiadot.org with the ap-
proval of  a member of  the Web section. After creating 
and/or gathering the information necessary for your 
page, log into the CMS, enter all your materials and sub-
mit the page for approval.

A member of  the Web section will approve or reject 
your content. If  approved, the content will be published 
live to Virginiadot.org. If  rejected, the content is sent 
back so you may make the necessary changes to have it 
approved. That’s it! Now you are ready to move on with 
your other tasks.

Username: The fi rst initial of  your fi rst name and 
your full last name (i.e., John Doe’s username would 
be jdoe) in lowercase letters
Password: The password should be Pa$$w0rd (It is 
the word “Password” with dollar signs substituted 
for the letter “S” and a number zero substituted for 
the letter “o.”)
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If  this is your fi rst time logging in, you will probably 
not know how to get around. The next section is a brief  
overview of  the CMS’s navigation system and how to 
get around it.

The CMS is:

A content management system for the Web pages   
 that create Virginiadot.org, including all supporting  
 images and documents, overseen by the Web 
 section in the Public Affairs Division.

Accessible from anywhere with an Internet connec 
 tion and Internet Explorer 6 or Internet Explorer 7.

A tool that helps content creators enter content   
 directly to Web pages and content editors to 
 edit pages.

The CMS is NOT:

FrontPage nor is affi liated with any Microsoft 
 product.

A communication system such as email or instant   
 messenger

Software to be downloaded or shared.
A repository for images, documents and multimedia  

 fi les.
A testing environment for software, hardware, multi 

 media or any other Web page or Web site  than 
 Virginiadot.org

A photo library.

Logging In

By entering the URL above in IE6 or IE7 you should 
see the login screen (Figure 1).

In the “Username” fi eld, enter the username you were 
given.

In the “Password” fi eld, enter the password you were 
given. Don’t worry about changing it right now. This will 
be covered in another section.

»

»

»

»

»

»
»

»

»

Introduction

Figure 1 - CrownPeak CMS login screen.



Virginia Department of  Transportation  |  CrownPeak CMS  |  Training Guide  |  7

Left-side navigation 

The left-side navigation (Figure 2) acts as a global navi-
gation throughout the site that contains ten links acces-
sible from anywhere in the site with the exception of  
the preview pages, in which case you would use the top 
navigation.

Home takes you back to the page you fi rst saw when  
 you logged on. What appears on the home page will  
 depend on the settings you save later on in your 
 preferences.

My Summary takes you a page that lists out the latest  
 activity in the CMS, specifi cally the “Last fi ve 
 pages you viewed,” the “Last fi ve modifi ed pages” 
 and “Recently added documents”. Also, if  a user in  
 the CMS locks any fi le it will appear on this screen  
 as well.

Preferences will give you the option to change the  
 screen that will appear when you login and an option  
 to change what page appears when you click on 
 the “Home” link on the left-side navigation. There 
 are other options on the “Preferences” page aside  
 from the two mentioned above that should not be 

»

»

»

NAVIGATION
Once in the CMS, there are two ways of  get-
ting around: the left-side navigation and the 
top navigation above the content. 

Figure 2 - CMS left-side navigation.
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 changed or altered in any way. There is a section   
 dedicated to changing these settings in the “User   
 Preferences and Settings.”

Tasks allow for any user to assign tasks to any other  
 user in the CMS without using email. In the task as 
 signment input box, there will be a drop-down menu  
 list of  all the possible users you can send a task to.  
 By assigning a task to someone, it will send a mes  
 sage to them containing the name of  the person 
 who sent them a task, level of  importance when   
 it was created, category, due date and any 
 associated comments. All but the “Assign back to”  
 fi eld is optional.

Workfl ow Tasks, Flagged, Queued, Modifi ed Pub  
 lished, and Modifi ed will seldom be used, if  at all.   
 If  the Web section fi nds it necessary to use any of   
 these fi elds, the team will address the functionally 
 and how to use these links on the training Web site. 
 Click around these links to explore, but please do   
 not alter any information that might be contained   
 inside them.

Logout allows you to logout of  the system 
 completely.

Other information on the left side include:
 Recent Activity – This will contain three to four 
 users depending on who is in the system. It will   
 show their name the amount of  minutes that have  
 lapsed since their last action and their respective   
 avatar images. Your username, last login date and  
 IP address from where you last logged into the 
 CMS.

»

»

»

»

Top Navigation

The Top navigation (Figure 3) changes relative to where 
you are on the site. If  you’re on the home page and 
hover over “File,” it will show you options to navigate 
throughout the CMS.

If  you were in a section of  the Web site, say the “Info” 
section and drop down the “File” menu, it will give you 
the same options but also have new options to select 
from such as creating a new page.

Figure 3 - CMS top navigation.

Navigation
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Getting to the Preferences Screen

To get to the “Preferences” screen (Figure 4) from the 
home screen, you have two options: There is a link on 
the left-side navigation labeled “Preferences” which 
you can click on, or you can use the top navigation and 
hover over System > My Account > then click on 
“Preferences.”

Once you get to the “Preference” screen, you will see 
that it is divided up into fi ve sections: Startup Preferenc-
es, Summary Page View, Email Alert Preferences, Folder 
Preferences and Other.

Startup Preferences

My home fi le/folder allows you to change the folder  
 you want to make your home for the CMS. For 
 example, if  you are an editor that only works on   
 news releases, you might want to set this to have the  
 “News” folder appear as your home folder to 
 bypass all the other screens. Please note that if  you  
 change this setting, you will also need to change the  
 “Login” and “Home” setting.

»

USER PREFERENCES & SETTINGS
Preferences allow you to customize how you 
view pages when you fi rst login and when you 
click on the “Home” link on the left-side nav-
igation. Settings allow you to perform tasks 
such as changing your username and password 
as well as be able to provide contact informa-
tion for other users in the CMS.

Login sets the screen that appears when you fi rst   
 login. The options are:

Show my summary view which will show a   
 screen of  the last fi ve pages you viewed, the last  
 fi ve modifi ed pages and recently added 
 documents.

Show my home fi le/folder which will show the  
 contents of  the folder you specifi ed in the 
 “My home fi le/folder” input box.

Show last fi le/folder which shows the fi le or   
 folder you accessed when you were last logged  
 in.

Home sets the screen you see when you click on the  
 “Home” link on the left-side navigation. The 
 options here are “Show summary view” and Show 
 my home fi le/folder, which are the same as in the   
 login section.

My default Browse State(s) affect the way you pre  
 view pages and these have been set so the view of  
 any given page by any user is the same. They should  
 not be changed or altered in any way unless directed  
 by the Web section.

»

»

»

»

»

»
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Summary Page View

This preference allows you to customize what you see 
when you click on the “My summary” link on the left-
side navigation.

Email Alert Preferences 

This sets what types of  email you receive when someone 
sends out a system-wide message, either when you’re 
part of  a group being notifi ed of  workfl ow or when 
there is a scheduled maintenance for the CMS. These 
boxes should be kept the way they are unless otherwise 
directed by the Web section.

Folder Preferences

“By default sort folder by” lets you set a default for  
 what category your folder is sorted by. You can drop  
 down the menu to see your options. 

The second setting is “Folder page size” which sets  
 the number of  fi les you see in a given folder. The   
 range of  fi le you’ll be able to view is from fi ve to 
 100 fi les.

»

»

Other 

There are other options in your preferences screen are 
“Hide side info panel” and “Hide Publish Popup.” 

The former gives you the option to show or hide   
 your left-side navigation. This option should always 
 be unchecked so all the information on the left is 
 available to you at all times. 

The latter hides the popup that appears when you  
 publish out pages.

Once you’ve completed going through your preferences, 
you need to make sure to click on the “Save” button 
available on the top and bottom right corners of  the 
preferences screen. Otherwise, click on “Cancel” to 
discard your changes.

Getting to the Settings Screen

There are two ways to get to the Settings screen: the fi rst 
is to locate the icon/avatar which should be the fi rst 
item on the left-side navigation and click on it; the sec-
ond method is to use the top navigation and hover over 
System > My Account > and click on Edit.

»

»

Figure 4 - User preference screen.
Figure 5 - User settings screen.

User Preferences & Settings
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Settings

There are a range of  personal options you can set in this 
screen (Figure 5): 

Expires on lets you set your account to expire on a  
 certain date. This fi eld should always be left blank.

Username is the name you use to login to the CMS.  
 Please note this fi eld if  you plan on changing your  
 username. This is a required fi eld.

Password changes the password you use to get into  
 the CMS. This is where you would change the 
 generic password given to you. Once you change it,  
 please take note of  it so you may remember it 
 easily when logging on at again. This is a required  

 fi eld. 

Password Again confi rms what you entered in the  
 “Password” fi eld. This is a required fi eld. 

Avatar Image is the image beside your name and   
 seen by other users in the CMS. To change this, click  
 on the default image currently in place and a popup  
 should appear with different options. Choose the 
 image you want to use by clicking on it. It will 
 appear in place of  the old image. Likewise, if  you   
 want to create your own and use it in the CMS, make  
 sure it is 32x32 pixels in size and upload it by 
 clicking the “Browse” button and selecting it. 

First name should only be changed if  you go by   
 something else other than what is already in the 
 input box. This is a required fi eld. 

Last Name should only be changed if  you go by   
 something else other that what is already in the input  
 box. This is a required fi eld.

Email is good to have for two functions: when 
 being assigned a task, the CMS will send you a 
 message to this email address. If  someone in the   
 CMS needs to contact you from an email account   
 outside of  the CMS, they can look up this 

»

»

»

»

»

»

»

»

 information. This is not a required fi eld, but would  
 be a good idea to provide one.

Title is already set for you, but there is an option to  
 change it.

Department is also preset, but can be changed.
Location is already set for you, but there is an option  

 to change it.
Offi ce, Fax, Cell, Pager Phone Numbers are not re 

 quired fi elds, but if  someone needs to contact you  
 via telephone, they can look up your information. At  
 the very least fi ll out an offi ce and cell phone num  
 ber just in case a user needs to get in touch with you.

Signature is an optional fi eld and is attached to any  
 message you send via the CMS.

Don’t worry about the “Groups” fi eld.
Once you’ve completed going through your options, 
click on the “Save” button available at the top and 
bottom right corner of  the screen. Otherwise, click on 
“Cancel” to discard your changes.

»

»
»

»

»

»

User Preferences & Settings
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To make it easier for you to quickly call “Assets” into 
pages, upload these fi les fi rst and then create your pages 
accordingly. There are three folders and procedures for 
uploading “Assets” into the CMS: the fi rst is for docu-
ments and multimedia fi les which are separated out into 
sections; the other is a video folder, also separated out 
into sections; the last folder is a general folder that con-
tains all the images in Virginiadot.org.

Getting to the Assets Folder

Once logged on, locate the top navigation and hover 
over File > Open and click on “Assets.” Here you will 
see a list of  folders with different types of  assets.

Uploading Images

Find the folder labeled “images and click on the folder 
icon beside it. Once in the “images” folder, locate the 
top navigation and hover over File > New > and click 
on “image.” This should bring you to an input screen 
where you can upload your image. The fi elds are as fol-
lows:

Filename lets you name the image you upload. Along  
 with the fi lename, you must remember to include   
»

UPLOADING ASSETS
Most pages in Virginiadot.org require supple-
mental information in the form of  images, 
documents, video and audio to be placed 
with the content. These fi les are appropriately 
called “Assets” in the CMS.

 the extension that came with the fi le. In other words,  
 if  you uploaded “sample.jpg”, you can still name the  
 fi le “sample”, but don’t forget to include the “.jpg”  
 fi le extension.

Image upload is where you will call your fi le from   
 your machine, a shared drive or a portable drive   
 into the CMS. Use the “Browse” button to show the  
 popup box and follow its instructions. Once you’ve 
 located and selected your image, click on “Upload”  
 and the input screen should give you a preview of   
 your image and its dimensions in relation to the   
 page. If  you make a mistake, the “Clear” button is 
 also there.

Alt text allows you to put a description of  the image.  
 It sits in the background and is commonly used to  
 make the Web page accessible to screen readers. This 
 is an important step to keeping Virginiadot.org 
 accessible to people with hearing and visual 
 impairments.

Caption acts the same as an alt text, but this text will  
 be visible and help describe what is happening in the  
 image. 

»

»

»
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Once you’ve completed going through the input boxes 
and are ready to upload the image, click on the “Save” 
button and this should bring you back to the fi le listing. 
Just to make sure, you should probably scroll through 
the image fi le list and look for the image fi lename to see 
that your image has been uploaded.

Uploading Documents, Video and Audio

The procedure for uploading these assets is the same as 
uploading an image, but their placement will be differ-
ent. The “Videos” folder is separated out into the major 
buckets of  information. For example, if  you have a 
video on a bridge project, you would simply locate the 
“projects” folder within video and upload it there. 

Documents and audio fi les are stored in the documents 
folder. Again, using “Projects” as an example, if  you had 
a PDF document or audio fi le you wanted to upload, 
navigate to the “documents” folder then “Projects” 
folder and upload both fi les there.

The procedure to upload is the same for all three fi les:
Once you’re in the correct folder, go to the top 

 navigation and hover over 
File > New > and then click on “Asset.”
Once you’re in the input screen, the only fi elds you  

 need to fi ll out are the “Filename” and “Label” fi eld.
Filename lets you fi nd the document on your local  

 machine, shared drive or portable drive and upload it  
 into the CMS. Click on “Browse” and a popup 
 should appear. Navigate to your fi le and click on   
 “Open” to select it.

Label is where you would place the fi lename of  your  
 asset. Don’t forget to include the extension of  the  
 fi le. Otherwise the fi le will not be valid when you try  
 to call it into a page.

»

»
»

»

»

All the other fi elds are not necessary for you to fi ll  
 out and will not affect your upload in any manner.  
 Feel free to leave these blank.

Once you’ve completed going through the necessary 
fi elds, click on the “Save” button. This will save your up-
load and bring you back to the fi le listing. It would be a 
good idea for you to check the fi le list for your fi le name 
to see if  your asset has uploaded properly. Otherwise, 
click on the “Cancel” button to discard your upload.

»

Uploading Assets
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They should seem familiar to you if  you’ve ever used 
any version of  Microsoft Word. It consists of  three 
parts: creating links, embedding images, documents and 
formatting tools.

Links

Creating links, whether it is to other pages in 
Virginiadot.org, an external Web site, a docu-
ment or someone’s email address, is an impor-

tant part of  a Web page. To create a link, fi rst enter your 
content in the body input box, highlight the text you 
want to turn into a link and click on one of  the follow-
ing icons:

Link to a document – Some pages require that you  
 upload and link to documents within the CMS to   
 support the content. The most common documents  
 Virginiadot.org pages link to are PDFs, Word or 
 Excel documents. Once you’ve clicked on this icon,  
 a popup box should come up. Navigate to the assets  
 folder > documents and select the folder which 
 contains your document. Once you fi nd your 

»

WYSIWYG OVERVIEW
WYSIWYG is an acronym for “What You 
See Is What You Get” and it is pronounced 
“whiz-ee-wig.” It refers to the set of  icons you 
use while creating new pages within the CMS. 

 document, highlight it by clicking on the line once.  
 Go to the bottom right corner and click on “Select.”

Link to an internal (Virginiadot.org) page – Use this  
 icon if  you need to link to any page within the 
 VDOT Web site. When you have your text 
 highlighted, click on the icon and a popup box   
 should appear. In the URL fi eld, choose “Other.” 
 This indicates the CMS that you want to call up an  
 internal document. In the next fi eld, click on the 
 button with the three periods to bring up another   
 popup box, this time to the fi le listing for 
 Virginiadot.org. Navigate to the page you want to 
 link to and highlight it by clicking on it once. Then  
 click on the “OK” button on the bottom-right side.

·Link to an external page – Linking to an external   
 page uses the same procedure as linking to an 
 internal page except in the URL drop-down menu,  
 select “http:” instead of  “other.” Also, instead of    
 clicking on the button with the three periods, type in  
 or paste the URL into the fi eld immediately below  
 the URL drop-down box.

»

»
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Linking to an email address – Again, use the same  
 procedure as linking to an internal page, but this   
 time, instead of  choosing “other” in the URL box,  
 select “mailto” and for the box immediately below 
 the drop-down box after “mailto”,  enter the email  
 address you want to link to.

Images

Images add emphasis to Web content and 
should be used when the opportunity is pre-
sented. To link an image to a Web page:

Click on the image icon to have the image popup box 
appear. In the fi rst fi eld, fi nd the image you want to use 
from the “Assets” folder within the CMS by clicking 
on the button with the three periods. The popup box 
that comes up when clicking on this button should look 
familiar since it uses the same format for when linking 
to an internal document. Once you fi nd your image fi le, 
highlight it by clicking on it once and click on the “Se-
lect” button on the bottom right corner. Once the image 
has been selected, the only other fi eld that needs to be 
fi lled out is the “Alternate Text” fi eld which you should 
provide for accessibility. Write a short description of  the 
images.

» Formatting Tools

This set of  icons (Figure 6) should look similar to the 
formatting icons used in Microsoft Word and should be 
self-explanatory:

Bold
Italic
Underline
Left align
Center align
Right align
Bullet list
Number list
Left indent
Right indent

»
»
»
»
»
»
»
»
»
»

Figure 6 - WYSIWYG formatting tools.

WYSIWYG Overview
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CREATING A NEWS RELEASE
News releases are used to communicate state-
wide or area specifi c news from VDOT and 
are always posted on the Web site. You can 
quickly draft your release in Microsoft Word 
and cut and paste it into the CMS.

News releases are used to communicate state-wide or area specifi c news from VDOT and are always posted on the 
Web site. You can quickly draft your release in Microsoft Word and cut and paste it into the CMS. One thing to note 
is that before starting on a news release, you should have a Word version of  your release ready to cut and paste into 
the CMS and supporting images and documents already uploaded into the “Assets” folder. Once logged on, follow 
these procedures to navigate and create your new release.

Find the folder labeled “News” and click on the folder icon beside it.

Using the top navigation, hover over File > Open > and click on VDOT 
to get to the Virginiadot.org folder listing.
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Creating a News Release

Once in the “News” folder, select the area the release applies to, fi nd 
its folder and click on the folder icon beside it. For this example, I’ll be 
using “Northern Virginia.” So click on the folder icon beside “North-
ern Virginia.”

Find the current year and click on the folder icon beside it.

Once you’re in the current year’s folder, hover over File > New > and 
click on “News Release.” This should bring up a dialogue box to 
guide you in creating a news release.

District is where you would select the district this release belongs to.

Contact is where you select the person who should be contacted if 
there are any questions or comments regarding this release. There is 
a drop-down menu with the most common names and their contact 
information. However, if you don’t fi nd the contact name that you 
need, the fi elds right below the drop-down menu should be fi lled 
out. This will automatically override the drop-down menu. If you need 
more than one contact for a release, fi nd the “Insert” button to the 
left of the “Contact” section and this will provide another name fi eld.
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Release Info is for the release’s title, date and article ID. This fi eld in-
cludes the breadcrumb title (which is usually just the fi rst four or fi ve 
words in a headline), the release title, a supporting subtitle, the date 
of the release and the article ID, if it has one.

Creating a News Release

Headline Image is where you can put a corresponding image with 
the release, a headline image caption to go with the image, and a 
summary where you can enter a summary that will show up in the 
“Headlines” section.

The summary section is where you can type in a few sentences that 
sums up the news release. This will show up in the “Headlines” page 
of the news section. Typically, the fi rst paragraph of the news release 
is entered here.

Last, you will see the “Body” section where you will put all the body 
copy of your content for the release.

Once you’ve completed going through the necessary fi elds, click on the “Save & Preview” button (Figure 7) on the 
top or bottom corners of  the input page to save all your information. Doing so will direct you to a page that will 
show you a preview of  what your page will look like within the Virginiadot.org layout. Clicking on “Cancel” dis-
cards all your changes.

Figure 7 - Saving options for your new page; this is available at the top or bottom right of  the input boxes.
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CREATING A PROJECT PAGE
Project pages help create awareness of  all the 
projects and VDOT is involved with as well as 
its status and contact information if  the pub-
lic has any questions about them. 

Creating a project page is very similar to creating a news release except for a few extra fi elds in the input page. Like 
the news release, you should have your project document ready to cut and paste and all your supporting images and 
documents uploaded into the “Assets” folder so that you can call them into the page when you’re ready.

Once logged on, use the top navigation and hover over File > Open > 
and click on “VDOT.” 

Once there fi nd the folder labeled “Projects” and click on the folder 
icon beside it.
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You should now be in another folder listing that includes all the 
districts available for you to create a project page in. For this example 
let’s use Bristol as an example. Find Bristol on the folder listing and 
click on the folder icon beside it.

Creating a Project Page

Once inside the Bristol folder, hover over File > New > and click on 
project. This should bring up an input page where you can enter in all 
the project details including any documents or images you need for 
the project.

To make sure that visitors of Virginiadot.org know when this page 
was last updated, specify the time this project page was last modi-
fi ed. Since this is a new page, just use the current date. If you were 
making updates, the date of the updates should be entered.

Under the “General Information” section, fi ll out the following 
fi elds: “CMS Title” is for the title that shows when looking at a list of 
project pages in the “Bristol” folder; “Short Title” will appear in the 
breadcrumbs; “Long Title” appears with the content; “Project Sub-
title” appears in the project listing page underneath the “Long Title;” 
then select the “Project Type” from the drop-dwon box.

The next section is for the project body copy.
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The next section is for the project body copy.

Creating a Project Page

If you haven’t already noticed, there are two parts to this page. Navi-
gate to the top where the tabs are located. They should be labeled 
“Main” and “At a Glance.” Once you’re fi nished with the “Main” 
section, click on “At a Glance” to get the second input page. Where 
the “Main” section took care of the content in the middle, this sec-
tion takes care of the column on the right side of project pages.

If you have a map of the project and available in an image format, 
you can put that in the “Map” section.

If you have one or more photos to share about the project, you can 
create a photo gallery in the next section called “Photo Gallery.”

The next section labeled “Project Details” is self-explanatory and con-
tains fi elds such as beginning date, cost, county, and district. These 
fi elds are not required and can be fi lled out according to the available 
information.
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In the “Contacts” fi eld, you can put the person to contact for this 
particular project’s inquiries. If there is more than one person available 
for contact, click on the button labeled “Insert” to create another 
contact form.

Creating a Project Page

Once you’ve completed going through all the information necessary for a project, click on “Save & Preview” (Fig-
ure 8) at the top or bottom corner of  input page to preview your work. Otherwise, click on the “Cancel” button to 
discard your changes. 

Figure 7 - Saving options for your new page; this is available at the top or bottom right of  the input boxes.
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STAGING PAGES
Once you’ve completed going through all 
your information in any new page you’ve cre-
ated or editing any existing page, you are now 
ready to have it reviewed by the Web section.

Highlight your document by cliking on it once making sure not to 
click on the fi le’s icon on the left side.

Go to the top navigation and hover over Edit > Draft > and click on 
“Send for Approval.”

This will prompt the Web section to check the submitted pages and let you know whether or not your page has been 
approved or rejected. If  it has been approved, no additional action is needed and the page will be moved to the stag-
ing area. If  rejected, you will be contacted about what you need to change, whether it is through the task system on 
the CMS, email or telephone, depending on how soon a page needs to be posted.
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Web section

Do you have any questions, comments or concerns   
about any of  the following topics?

Virginiadot.org
CrownPeak CMS
Feedback (Virginiadot.org or training for Crown  

 Peak)
How to write for the Web
Training sessions, content, or documents
Training Web site

Please contact: 
Wayne Scarberry

Web Content Manager
804-371-6849
wayne.scarberry@vdot.virginia.gov 

»
»
»

»
»
»

GETTING HELP
Questions, comments, concerns or sug-
gestions for the CMS or Virginiadot.org in 
general? Use one of  the following methods 
below.

Online Reference

If  there are changes to the CMS that are not refl ected in 
this guide such as menus, input pages or any other gen-
eral changes in the CMS, this information is also posted 
in the training Web site. Additional resources include a 
style guide for writing for the Web, this guide in PDF 
format for internal distribution, transcripts to the avail-
able videos and modules for the sections in this guide. 
This guide and supporting materials for the CrownPeak 
CMS can be found online at
http://cowwwdev1/cms_training/index.html.


